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Preface

Welcome to the Opsware Operational Management Database (OMDB), the first
configuration management database (CMDB) that offers seamless change automation.
Leveraging the Opsware System consisting of the Opsware Server Automation System
(SAS), Opsware Network Automation System (NAS), and the Opsware Application Storage
Automation System (ASAS), the OMDB automatically populates and maintains all the
infrastructure configuration items (Cls), their detailed attributes, and interdependencies.
After the OMDB is populated with the data, customers can easily execute changes to
configure and remediate the IT infrastructure.

Overview of this Guide

This guide describes installing OMDB and Data Miners, and how to perform OMDB
administrative tasks.

Contents of this Guide

This guide contains the following chapters and appendices:

Chapter 1: Supported Operating Systems: Describes the supported operating systems
for an Opsware OMDB core, OMDB Database, and the OMDB Client.

Chapter 2: Installing OMDB: Describes how to install OMDB Core and Database
instances, and how to configure SAS groups to permit access to OMDB.

Chapter 3: Installing OMDB Data Miners: Describes how to install OMDB Data Miners.
Chapter 4: Administrative Tasks: Describes the OMDB filesystem layout, viewing and
setting OMDB permissions, creating and assigning security boundaries, and the OMDB
start script.
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Chapter 1: Supported Platforms

This chapter discusses the following topics:

« Supported Operating Systems for OMDB Core Servers

+ Supported Operating Systems for the OMDB Client
« Supported Data Sources for OMDB Data Miners

+ Hardware Requirements for OMDB Core Servers

Supported Operating Systems for OMDB Core Servers

The following table lists the supported operating systems for the Opsware OMDB core

components.

Table 1-1: Opsware OMDB Core Supported Operating Systems

Sun Solaris Solaris 9 Sun SPARC

Sun Solaris Solaris 10 Sun SPARC

Red Hat Linux Red Hat Enterprise | 32 bit x86
Linux 3 AS

Red Hat Linux Red Hat Enterprise | 64 bit x86
Linux 4 AS

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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Supported Operating Systems for the OMDB Client
The following table lists the operating systems supported for the OMDB Client.

Table 1-2: OMDB Client Supported Operating Systems

SUPPORTED
OPERATING SYSTEMS VERSIONS ARCHITECTURE
FOR OMDB CLIENT
Windows Windows XP 32 bit x86
Windows 2003 32 bit x86
Windows 2000 32 bit x86

Supported Data Sources for OMDB Data Miners
See “Supported Data Sources for OMDB Data Miners” on page 47.

Hardware Requirements for OMDB Core Servers

See the Opsware® SAS Planning and Installation Guide for information on the hardware
requirements.

1 0 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.



Chapter 2: Pre-Installation Requirements

This chapter discusses the following topics:
* Installing SAS
* Pre-Install Script Requirements
* Viewing OMDB Permissions
» Enabling the OMDB Client

+ Open Ports

Installing SAS
Using the supplied Opsware SAS install DVD, install a SAS 7.0 core.

For more information, see the Opsware® SAS Planning and Installation Guide.

Pre-Install Script Requirements

Before you begin installing OMDB, you should have the following two pieces of
information:

+ The fully qualified domain name or IP address of the server on which the Opsware
Command Center (OCC) core component is installed.

» The password for the admin user of the SAS installation (the cast.admin pwd
parameter value).

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 11
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Viewing OMDB Permissions

This section describes how to view OMDB permissions for an existing group, and the
definitions of the permission settings.

Viewing OMDB Permissions
To view the OMDB permissions, perform the following steps:
E Login to the SAS Web Client as admin.

H n the Navigation Panel, click Administration » Users and Groups. The View Users
pane appears.

E Click the Groups tab.
Bl Select a group. The group is displayed in the View Groups pane.
H Click the OMDB Features tab.

If a user has no OMDB permissions, the SAS Client will not display the Opsware OMDB
Client item on the Tools menu.

OMDB Permissions
The General Permissions section has the following five checkboxes:

» Schedule Reports - Selecting Schedule Reports causes the OMDB Client to display the
Schedule Reports item in the View » Reports menu. It also enables the Schedule
button when the user views a specific report.

+ Manage Scheduled Reports - In addition to the permissions granted by selecting
Schedule Reports, selecting Manage Scheduled Reports also causes the OMDB Client
to display the Manage Scheduled Reports item in the View » Opsware
Administration menu. The user can see scheduled reports of other users, set the
maximum number of scheduled reports per user, and set the maximum number of
reports to be concurrently processed by a server. This permission grants access to only
the report definitions of scheduled reports. If the user runs a report created by another
user, the data displayed depends on the Data Access permissions. If the user runs a
report that attempts to display data the user does not have access to, the report
displays the following message: “There is no data that matches your criteria”.

+ Manage Security Boundaries -Selecting Manage Security Boundaries adds the
Security Boundaries item on the menu View » Opsware Administration menu of
the OMDB Client to members of the group. The user can create security boundaries.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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+ Administer OMDB System - Selecting Administer OMDB System permits the user
access to CDK-related APIs.

« All Data Access Permissions - Selecting All Data Access Permissions grants members
of the group access to all data in OMDB. Clear All Data Access Permissions, then use
the Data Access section to grant data access to only selected categories.

Data Access

The Data Access section of the OMDB Features tab has two sections:
* NAS Category and Permission

+ SAS Category and Permission

Each section describes one row for each Configuration Item (Cl) Type in that section. If
custom CI Types are defined in the SAS installation, those data types are displayed in a
third section labeled Other.

For each Cl Type, set the permission for the group by selecting either None, All, or
Security Boundary. If you select the Security Boundary option, click Select to display the
Select Security Boundaries window.

Enabling the OMDB Client

You must enable OMDB on the SAS server, and you must also create an OMDB group
and add a user to that group before that user can see the Opsware OMDB Client menu
item in the SAS Client.

Enabling OMDB in SAS

To enable OMDB in SAS, perform the following steps:
H On the twist server, log in as root.

H Enter the following command:

/opt/opsware/omdb/bin/enable omdb client.sh
E Restart the twist:

/etc/init.d/opsware-sas restart twist

If you did not install OMDB on the server that the twist is installed on, you must copy
enable omdb client.sh from the OMDB server. Instead of the command in step 2,
enter the following commands:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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scp youromdbserver:/opt/opsware/omdb/bin/enable omdb

client.sh /var/tmp

/var/tmp/enable omdb client.sh

Then restart the twist as shown in step 3.

Enabling the OMDB Client Menu Item in the SAS Client

To enable the OMDB Client menu item in the SAS Client, perform the following steps:

B Log in to the SAS Web Client as admin.
H In the Navigation panel, click Administration » Users and Groups. The View Users
pane appears.
E Click the Groups tab.
B Click New Group.
1. Type a name for the group.
2. (Optional) Type the Group description.
B Click Save. The new group is displayed in the Groups pane.
@ Click the name of the group you just created.
In the Edit Group pane, assign the users to the OMDB group.
B Click the OMDB Features tab.
El Inthe General Permissions section, select all five of the checkboxes.
KK Click Save.
Open Ports

The following table lists the ports required for OMDB.

Table 2-1: OMDB Required Ports

25 (TCP) SMTP OMDB Core Mail Server
443 (TCP) Web Services OMDB Client SAS OCC
1032 (TCP) SAS Twist OMDB Core SAS OCC

14 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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Table 2-1: OMDB Required Ports

1521 (TCP) Oracle TNS OMDB Core OMDB Database
8443 (TCP) Web Services + OMDB Client OMDB Core

« Data Miner on a
Managed Server

8080 (TCP) OMDB Client OMDB Client OMDB Core
Download
8873 (TCP) RSYNC Data Miner Data Miner on a OMDB Core

Managed Server

14445 (TCP) RMI Over SSL OMDB Client OMDB Core

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 1 5
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Chapter 3: Installing OMDB

This chapter discusses the following topics:
« Compatibility
+ Overview
+ Installing OMDB on a Single Server
+ Installing OMDB and SAS on Separate Servers
+ Installing the OMDB Core, the OMDB Database, and SAS on Separate Servers

Compatibility

OMDB 7.0 is compatible with the 7.0 version of Opsware SAS. In the SAS Client, check the
version by selecting the Help » About menu item.

Overview

This chapter describes the following installation scenarios:

+ Installing SAS, the OMDB Core, and the OMDB Database on a single server. SAS and
OMDB share a single Oracle RDBMS. See “Installing OMDB on a Single Server” for
more information.

+ Installing SAS and OMDB on two separate servers. SAS and OMDB have separate
Oracle database instances.

« Installing SAS on one server, the OMDB Core on a second server, and the OMDB
database instance on a third server.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 17
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See “OMDB Filesystem Layout” on page 76 for a description of the files installed by the
OMDB Installer and their locations.

Installing OMDB on a Single Server

This section describes the concurrent installation of the Opsware OMDB Database and
the Opsware OMDB Core Services on the same server that Opsware SAS is installed on.
The OMDB install process uses the same Opsware Installer application that you used to
install Opsware SAS, and you start it in the same manner. When running the Opsware
Installer, press Ctrl+I at any time to display online help for the current step.

The OMDB hardware requirements for installation are the same as the Opsware SAS
hardware requirements. For more information, see the Opsware® SAS Planning and
Installation Guide.

Installing OMDB Using Simple Interview Mode

To install OMDB using the Simple Interview Mode, complete the following steps:

H Log in to the server that you installed SAS on, and then launch a command prompt.

H Mount the Opsware OMDB install DVD using a command similar to mount /dev/
cdrom as appropriate.

H From the Opsware OMDB install DVD, start the Opsware Installer using the following
command:

/<mnt_point>/opsware_installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware
Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

1 8 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

To select the Simple Interview mode, type 1, then press Enter. The following prompt
appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry

Control-I - show this menu, plus information about the
current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 9 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 9 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 9 (omdb.oracleSid)Please enter the SID for the
OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 9 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 1 9
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Parameter 5 of 9 (omcs.twistUser)Please enter the username of
a SAS admininstator for OMDB to use to connect to the twist.
[admin] :

To accept the default value admin, press Enter. The following prompt appears:

Parameter 6 of 9 (omcs.twistPwd)Please enter the password for
the SAS admin user for OMDB to use to connect to the twist.:

EIJ Type the password for the admin account on the SAS installation (the

cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 7 of 9 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

EEB Type the fully qualified domain name or IP address of the server that you are

installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 8 of 9 (omdb.adminPwd)Please enter the password to
use for the OMDB database administrator.:

EH To accept the default value cmdb_admin, press Enter.

The following prompt appears:

Parameter 9 of 9 (omcs.smtpHost)Please enter the hostname or
IP address of your SMTP mail server. [localhost]:

Consider using a non-default password.

EEl Perform one of the following two actions:

+ Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:

All parameters have values. Do you wish to finish the
interview? (y/n):

20 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.
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K To finish the interview, type y, then press Enter. The following prompt appears:

Concluding interview.
Interview complete.
Name of response file to write [/usr/tmp/oiresponse.omdb] :

EE To accept the default value /usr/tmp/oiresponse . omdb, press Enter. The
following prompt appears:

Response file written to /usr/tmp/oiresponse.omdb.
Would you like to continue the installation using this
response file? (y/n):

K3 To continue, type v, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 ( ) Oracle RDBMS for OMDB

2 () Opsware OMDB Database Instance

3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'gq' to quit.
Selection:

Because this installation is of SAS, the OMDB Core, and the OMDB Database on a single
server, selecting all components is appropriate. For more information, see “Installing
OMDB on a Single Server” on page 18.

To select all, type a, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.

Please select the components to install.
1 (*) Oracle RDBMS for OMDB

2 (*) Opsware OMDB Database Instance

3 (*) Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

EE To continue, type ¢, then press Enter. The following prompt appears:

Installing preliminary components

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 21
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Database with cryptographic material not found. Would you
like Opsware Installer to generate new database of
cryptographic material? [y/n]

EE] Perform one of the following two actions:
* Typey, then Enter.

+ To use existing cryptographic information, contact Opsware Technical Support for
more information.

The following prompt appears:

Invoking OCT, this may take a while...

>>>>Installing component Oracle RDBMS for OMDB

Opsware Installer ran successfully.

For more details, please see the following file:
/var/log/opsware/install opsware/
install opsware.2007-02-26.21:30:54 verbose.log

HFHAHHAHAHHEH AR H AR R R R R A R R
WARNING: to make sure that no sensitive information is left
on this server, please remove,encrypt or copy to a secure
location
the following files and directories:

-- /var/opt/opsware/install opsware/resp/*

-- /var/log/opsware/install opsware/*

-- /var/tmp/*.sh
Also, please encrypt or store in a secure location the
response file
that you used to install this core.
HFHAEHHAHAH HEH AR H AR R R R R R R R

Script done on Mon Feb 26 21:39:23 2007

You have completed installing OMDB.
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Installing OMDB Using Advanced Interview Mode

To install OMDB using the Advanced Interview Mode, complete the following steps:

Log in to the server that you installed SAS on, and then launch a command prompt.

Mount the Opsware OMDB install DVD using a command similar to mount /dev/
cdrom as appropriate.

From the Opsware OMDB install DVD, start the Opsware Installer using the following
command:

/<mnt_point>/opsware_installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware

Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

To select the Advanced Interview mode, type 2, then press Enter. The following
prompt appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry

Control-I - show this menu, plus information about the
current parameter
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Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 20 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 20 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 20 (omdb.oracleSid)Please enter the SID for
the OMDB Oracle database instance. [cmdb]:

Type the password for the Oracle SID, and then press Enter. The following prompt
appears:

Parameter 4 of 20 (omdb.sysPwd)Please enter the password to
use for the OMDB Oracle SYS user.:

Type the password for the Oracle system password, and then press Enter. The
following prompt appears:

Parameter 5 of 20 (omdb.systemPwd)Please enter the password
to use for the OMDB Oracle SYSTEM user.:

Type the password for the SYS user for the OMDB Oracle database instance, and
then press Enter. The following prompt appears:

Parameter 6 of 20 (omdb.pgaAggrTarget)Please enter the value
to use for the PGA AGGREGATE TARGET for the OMDB Oracle
instance (in Megabytes). [80]:

KK To accept the default value 80 for the Oracle sizing parameter, press Enter. The

following prompt appears:

Parameter 7 of 20 (omdb.sgaTarget)Please enter the value to
use for the SGA TARGET for the OMDB Oracle instance (in
Megabytes) . [150]:

EEl To accept the default value 150 for the Oracle sizing parameter, press Enter. The

following prompt appears

Parameter 8 of 20 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:
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EH Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 9 of 20 (omcs.twistUser)Please enter the username
of a SAS admininstator for OMDB to use to connect to the
twist. [admin]:

EE To accept the default value admin, press Enter. The following prompt appears:
Parameter 10 of 20 (omcs.twistPwd)Please enter the password
for the SAS admin user for OMDB to use to connect to the
twist.:

K1 Type the password for the admin account on the SAS installation (the
cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 11 of 20 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

EH Type the fully qualified domain name or IP address of the server that you are
installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 12 of 20 (omcs.port)Please enter the port on which
the OMDB Core Services will run. [8443]:

EI3 To accept the default value 8443, press Enter. The following prompt appears:

Parameter 13 of 20 (omcs.rsyncPort)Please enter the port on
which the rsync service will run. [8873]:

To accept the default value 8873, press Enter. The following prompt appears:

Parameter 14 of 20 (omcs.rmiObjectPort)Please enter the port
on which RMIObject should run. [14445]:

EE] To accept the default value 14445, press Enter. The following prompt appears:

Parameter 15 of 20 (omcs.webServicesPort)Please enter the
port on which WebServices should run. [8083]:

EE] To accept the default value 8083, press Enter. The following prompt appears:
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Parameter 16 of 20 (omdb.adminPwd)Please enter the password
to use for the OMDB database administrator.:

H Type the password, and then press Enter. The following prompt appears:

Parameter 17 of 20 (omdb.applPwd)Please enter the password to
use for the OMDB database applications user.:
Consider using a non-default password.

EXl Type the password, and then press Enter. The following prompt appears:

Parameter 18 of 20 (omdb.reporterPwd)Please enter the
password to use for the OMDB database reporter user.:

EH Type the password, and then press Enter. The following prompt appears:

Parameter 19 of 20 (omcs.smtpHost)Please enter the hostname
or IP address of your SMTP mail server. [localhost]:

EE] Perform one of the following two actions:
+ Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:

Parameter 20 of 20 (omcs.smtpPort)Please enter the port on
which your SMTP mail server is listening. [25]:

EXA To accept the default value 25, press Enter. The following prompt appears

All parameters have values. Do you wish to finish the
interview? (y/n):

To finish the interview, type vy, then press Enter.

To complete the installation, see step 14 on page 21, and then complete steps 14-19.
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Installing OMDB and SAS on Separate Servers

This section describes the installation of the Opsware OMDB Database and the Opsware
OMDB Core Services on a separate server that the SAS server was installed on. The
OMDB install process uses the same Opsware Installer application that you used to install
Opsware SAS, and you start it in the same manner. The OMDB hardware requirements for
installation are the same as the Opsware SAS hardware requirements.

For more information, see the Opsware® SAS Planning and Installation Guide.

Installing OMDB Using Simple Interview Mode
To install OMDB using the Simple Interview Mode, complete the following steps:

H Log in to the server you want to install the Opsware OMDB Database and the
Opsware OMDB Core Services on.

H Mount the Opsware OMDB install DVD using a command similar to mount /dev/
cdrom as appropriate.

EH From the Opsware OMDB install DVD, start the Opsware Installer using the following
command:

/<mnt_point>/opsware_installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware

Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

Bl To select the Simple Interview mode, type 1, then press Enter. The following prompt
appears:
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The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry

Control-I - show this menu, plus information about the
current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 9 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 9 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 9 (omdb.oracleSid)Please enter the SID for the
OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 9 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 5 of 9 (omcs.twistUser)Please enter the username of
a SAS admininstator for OMDB to use to connect to the twist.
[admin] :

To accept the default value admin, press Enter. The following prompt appears:

Parameter 6 of 9 (omcs.twistPwd)Please enter the password for
the SAS admin user for OMDB to use to connect to the twist.:
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K Type the password for the admin account on the SAS installation (the
cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 7 of 9 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

KBl Type the fully qualified domain name or IP address of the server that you are
installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:
Parameter 8 of 9 (omdb.adminPwd)Please enter the password to
use for the OMDB database administrator.:

EE To accept the default value cmdb_admin, press Enter.

The following prompt appears:

Parameter 9 of 9 (omcs.smtpHost)Please enter the hostname or
IP address of your SMTP mail server. [localhost]:

Consider using a non-default password.

EEl Perform one of the following two actions:
+ Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:
All parameters have values. Do you wish to finish the
interview? (y/n):

KK To finish the interview, type vy, then press Enter. The following prompt appears:

Concluding interview.
Interview complete.
Name of response file to write [/usr/tmp/oiresponse.omdb] :
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EBE To accept the default value /usr/tmp/oiresponse.omdb, press Enter. The

following prompt appears:

Response file written to /usr/tmp/oiresponse.omdb.
Would you like to continue the installation using this
response file? (y/n):

E3 To continue, type v, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 () Oracle RDBMS for OMDB
2 () Opsware OMDB Database Instance
3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .
When ready, press 'c' to continue, or 'g' to quit.

Because this configuration is installing SAS on one server and installing all of the
OMDB components on the current server, selecting all components is appropriate.
For more information, see “Installing OMDB and SAS on Separate Servers” on page
27.

To select all, type a, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.

Please select the components to install.

1 (*) Oracle RDBMS for OMDB

2 (*) Opsware OMDB Database Instance

3 (*) Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

EE To continue, type ¢, then press Enter. The following prompt appears:

Installing preliminary components

Database with cryptographic material not found. Would you
like Opsware Installer to generate new database of
cryptographic material? [y/n]

EE] Perform one of the following two actions:

« Typey, then Enter.
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+ To use existing cryptographic information, contact Opsware Technical Support for
more information.

The following prompt appears:

Invoking OCT, this may take a while...

>>>>Installing component Oracle RDBMS for OMDB

Opsware Installer ran successfully.

For more details, please see the following file:
/var/log/opsware/install opsware/
install opsware.2007-02-26.21:30:54 verbose.log

HEHSHHSHHE S HE S HS S H S HE S H SSRGS RS SRS S R R R SR
WARNING: to make sure that no sensitive information is left
on this server, please remove,encrypt or copy to a secure
location
the following files and directories:

-- /var/opt/opsware/install opsware/resp/*

-- /var/log/opsware/install opsware/*

-- /var/tmp/*.sh
Also, please encrypt or store in a secure location the
response file
that you used to install this core.
HEHSEHEHHE S H S H S H S H S S S S S S S R R

Script done on Mon Feb 26 21:39:23 2007

You have completed installing OMDB.

Installing OMDB Using Advanced Interview Mode

To install OMDB using the Advanced Interview Mode, complete the following steps:

Log in to the server you want to install the Opsware OMDB Database and the
Opsware OMDB Core Services on.

Mount the Opsware OMDB install DVD using a command similar to mount /dev/
cdrom as appropriate.
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H From the Opsware OMDB install DVD, start the Opsware Installer using the following
command:

/<mnt_points>/opsware installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware

A
Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

Bl To select the Advanced Interview mode, type 2, then press Enter. The following
prompt appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry

Control-I - show this menu, plus information about the
current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 20 (decrypt passwd)Please enter the password
for the cryptographic material:
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Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 20 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 20 (omdb.oracleSid)Please enter the SID for
the OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 20 (omdb.sysPwd)Please enter the password to
use for the OMDB Oracle SYS user.:

Type the password for the Oracle system password, and then press Enter. The
following prompt appears:

Parameter 5 of 20 (omdb.systemPwd)Please enter the password
to use for the OMDB Oracle SYSTEM user.:

Type the password for the SYS user for the OMDB Oracle database instance, and
then press Enter. The following prompt appears:

Parameter 6 of 20 (omdb.pgaAggrTarget)Please enter the value
to use for the PGA AGGREGATE TARGET for the OMDB Oracle
instance (in Megabytes). [80]:

KX To accept the default value 80 for the Oracle sizing parameter, press Enter. The

following prompt appears:

Parameter 7 of 20 (omdb.sgaTarget)Please enter the value to
use for the SGA TARGET for the OMDB Oracle instance (in
Megabytes) . [150]:

EEl To accept the default value 150 for the Oracle sizing parameter, press Enter. The

following prompt appears

Parameter 8 of 20 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

EH Type the fully qualified domain name or IP address of the server that the Opsware

Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 9 of 20 (omcs.twistUser)Please enter the username
of a SAS admininstator for OMDB to use to connect to the
twist. [admin]:

EE To accept the default value admin, press Enter. The following prompt appears:
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Parameter 10 of 20 (omcs.twistPwd)Please enter the password
for the SAS admin user for OMDB to use to connect to the
twist.:

K1 Type the password for the admin account on the SAS installation (the
cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 11 of 20 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

EH Type the fully qualified domain name or IP address of the server that you are
installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Parameter 12 of 20 (omcs.port)Please enter the port on which
the OMDB Core Services will run. [8443]:

K3 To accept the default value 8443, press Enter. The following prompt appears:
Parameter 13 of 20 (omcs.rsyncPort)Please enter the port on
which the rsync service will run. [8873]:

To accept the default value 8873, press Enter. The following prompt appears:
Parameter 14 of 20 (omcs.rmiObjectPort)Please enter the port
on which RMIObject should run. [14445]:

EE] To accept the default value 14445, press Enter. The following prompt appears:
Parameter 15 of 20 (omcs.webServicesPort)Please enter the
port on which WebServices should run. [8083]:

EE] To accept the default value 8083, press Enter. The following prompt appears:
Parameter 16 of 20 (omdb.adminPwd)Please enter the password
to use for the OMDB database administrator.:

EX Type the password, and then press Enter. The following prompt appears:

Parameter 17 of 20 (omdb.applPwd)Please enter the password to
use for the OMDB database applications user.:
Consider using a non-default password.

EXl Type the password, and then press Enter. The following prompt appears:
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Parameter 18 of 20 (omdb.reporterPwd)Please enter the
password to use for the OMDB database reporter user.:

EH Type the password, and then press Enter. The following prompt appears:

Parameter 19 of 20 (omcs.smtpHost)Please enter the hostname
or IP address of your SMTP mail server. [localhost]:

EE] Perform one of the following two actions:
+ Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:
Parameter 20 of 20 (omcs.smtpPort)Please enter the port on
which your SMTP mail server is listening. [25]:
EXA To accept the default value 25, press Enter. The following prompt appears
All parameters have values. Do you wish to finish the

interview? (y/n):

To finish the interview, type vy, then press Enter.

To complete the installation, see step 14 on page 29, and then complete steps 14 to 19.
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Installing the OMDB Core, the OMDB Database, and SAS
on Separate Servers

This section describes the installation of SAS on one server, the OMDB Core on a second
server, and the OMDB database instance on a third server. The OMDB install process
uses the same Opsware Installer application that you used to install Opsware SAS, and
you start it in the same manner. The OMDB hardware requirements for installation are the
same as the Opsware SAS hardware requirements.

For more information, see the Opsware® SAS Planning and Installation Guide.

Installing OMDB Using Simple Interview Mode
To install OMDB using the Simple Interview Mode, complete the following steps:

H Log in to the server you want to install the Opsware OMDB Database Services on.
This server will be referred to as the OMDB Database server.

H Mount the Opsware OMDB install DVD using a command similar to mount /dev/
cdrom as appropriate.

H From the Opsware OMDB install DVD, start the Opsware Installer using the following
command:

/<mnt_points>/opsware installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware
Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode

Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

Bl To select the Simple Interview mode, type 1, then press Enter. The following prompt
appears:
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The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry

Control-I - show this menu, plus information about the
current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 9 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:

Parameter 2 of 9 (omdb.oracleHost)Please enter the hostname
of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:

Parameter 3 of 9 (omdb.oracleSid)Please enter the SID for the
OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 9 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed on, then press Enter. The
following prompt appears:

Parameter 5 of 9 (omcs.twistUser)Please enter the username of
a SAS admininstator for OMDB to use to connect to the twist.
[admin] :

To accept the default value admin, press Enter. The following prompt appears:

Parameter 6 of 9 (omcs.twistPwd)Please enter the password for
the SAS admin user for OMDB to use to connect to the twist.:
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KK Type the password for the admin account on the SAS server (the cast .admin_
passwd parameter value), then press Enter. The following prompt appears:

Parameter 7 of 9 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost) .:

EEB Type the fully qualified domain name or IP address of the server that you will install
OMDB Core Services on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:
Parameter 8 of 9 (omdb.adminPwd)Please enter the password to
use for the OMDB database administrator.:

K To accept the default value cmdb_admin, press Enter.
The following prompt appears:

Parameter 9 of 9 (omcs.smtpHost)Please enter the hostname or
IP address of your SMTP mail server. [localhost]:

Consider using a non-default password.

EE] Perform one of the following two actions:
* Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:
All parameters have values. Do you wish to finish the
interview? (y/n):

KB To finish the interview, type y, then press Enter. The following prompt appears:

Concluding interview.
Interview complete.
Name of response file to write [/usr/tmp/oiresponse.omdb] :

KB To accept the default value /usr/tmp/oiresponse.omdb, press Enter. The
following prompt appears:
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Response file written to /usr/tmp/oiresponse.omdb.
Would you like to continue the installation using this
response file? (y/n):

K3 To continue, type v, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 () Oracle RDBMS for OMDB

2 () Opsware OMDB Database Instance

3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

To select Opsware Oracle RDBMS for OMDB and Opsware OMDB Database

Instance, type 1, then press Enter, and then type 2, then press Enter. The following

prompt appears:

Welcome to the Opsware Installer.

Please select the components to install.
1 (*) Oracle RDBMS for OMDB

2 (*) Opsware OMDB Database Instance

3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'qg' to quit.
Selection:

EE] To continue, type ¢, then press Enter. The following prompt appears:

Installing preliminary components

Database with cryptographic material not found. Would you

like Opsware Installer to generate new database of
cryptographic material? [y/n]

EE] Perform one of the following two actions:

« Typey, then Enter.

» To use existing cryptographic information, contact Opsware Technical Support for

more information.

The following prompt appears:
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Invoking OCT, this may take a while...

>>>>Installing component Oracle RDBMS for OMDB

Opsware Installer ran successfully.

For more details, please see the following file:
/var/log/opsware/install opsware/
install opsware.2007-02-26.21:30:54 verbose.log

HFHAESHAHAHHEH AR H AR R R R A R
WARNING: to make sure that no sensitive information is left
on this server, please remove,encrypt or copy to a secure
location
the following files and directories:

-- /var/opt/opsware/install opsware/resp/*

-- /var/log/opsware/install opsware/*

-- /var/tmp/*.sh
Also, please encrypt or store in a secure location the
response file
that you used to install this core.
HFHAEHHAHAHHEH A H A H AR R A R R A R

Script done on Mon Feb 26 21:39:23 2007

X On the server that you intend to install OMDB Core Services on, open a command

prompt.

EXl To copy the oiresponse . omdb file from the OMDB Database server to the OMDB

Core server, enter the following command:

scp omdbdatabaseserver:/usr/tmp/oiresponse.omdb

EH Mount the Opsware OMDB install DVD using a command similar to mount /dev/

cdrom as appropriate.

EEl From the Opsware OMDB install DVD, start the Opsware Installer using the following

command:

/<mnt_points>/opsware installer/install opsware.sh -r /usr/
tmp/oiresponse.omdb

EXA To continue, type vy, then press Enter. The following prompt appears:

Welcome to the Opsware Installer.

Please select the components to install.
1 () Oracle RDBMS for OMDB

2 () Opsware OMDB Database Instance
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3 () Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

EH To select Opsware OMDB Core Services, type 3, then press Enter. The following
prompt appears:

Welcome to the Opsware Installer.
Please select the components to install.

1 () Oracle RDBMS for OMDB

2 () Opsware OMDB Database Instance

3 (*) Opsware OMDB Core Services

Enter a component number to toggle ('a' for all, 'n' for
none) .

When ready, press 'c' to continue, or 'g' to quit.
Selection:

H3 To continue, type ¢, then press Enter. The following prompt appears:

Installing preliminary components

Database with cryptographic material not found. Would you
like Opsware Installer to generate new database of
cryptographic material? [y/n]

Perform one of the following two actions:

« Typey, then Enter.

» To use existing cryptographic information, contact Opsware Technical Support for
more information.

The following prompt appears:

Invoking OCT, this may take a while...

>>>>Installing component Opsware OMDB Core Services
Opsware Installer ran successfully.
For more details, please see the following file:
/var/log/opsware/install opsware/

install opsware.2007-02-26.22:30:54 verbose.log

FHAFHAHAFHAHHAH AT HAH AT HAHHAH AT H A SR A H A A A A AR
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WARNING: to make sure that no sensitive information is left
on this server, please remove,encrypt or copy to a secure
location
the following files and directories:

-- /var/opt/opsware/install opsware/resp/*

-- /var/log/opsware/install opsware/*

-- /var/tmp/*.sh
Also, please encrypt or store in a secure location the
response file
that you used to install this core.
HFHAHHAHAH HEH AR H AR R R A R

Script done on Mon Feb 26 22:39:23 2007

You have completed installing OMDB.

Installing OMDB Using Advanced Interview Mode

To install OMDB using the Advanced Interview Mode, complete the following steps:

Log in to the server you want to install the Opsware OMDB Database Services on.

Mount the Opsware OMDB install DVD using a command similar to mount /dev/
cdrom as appropriate.

From the Opsware OMDB install DVD, start the Opsware Installer using the following
command:

/<mnt_points>/opsware installer/install opsware.sh

Start the Opsware Installer using the fully qualified path name. Do not start the Opsware
Installer from the local directory.

The following prompt appears:

Install Type: "OMDB Installation"

Please select the interview mode. Simple mode uses default
values for many of the configuration parameters. Advanced
mode allows you to fully configure the installation.

1 - Simple Interview Mode
2 - Advanced Interview Mode
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Please select the interview mode from the menu, type ‘h’ for
help, ‘g’ to quit:

To select the Advanced Interview mode, type 2, then press Enter. The following
prompt appears:

The Opsware Installer will now interview you to obtain the
installation parameters it needs. You can use the following
keys to navigate forward and backward through the list of
parameters:

Control-P - go to the previous parameter

Control-N - go to the next parameter

Return - accept the default (if any) and go to the next
parameter

Control-F - finish parameter entry

Control-I - show this menu, plus information about the
current parameter

Press Control-F when you are finished. The Opsware Installer
will perform a final validation check and write out a
response file that will be used to install the Opsware
components.

Parameter 1 of 20 (decrypt passwd)Please enter the password
for the cryptographic material:

Type the cryptographic password to use. The following prompt appears:
Parameter 2 of 20 (omdb.oracleHost)Please enter the hostname

of the server where the Oracle RDBMS will be installed.
[localhost] :

To accept the default value localhost, press Enter. The following prompt appears:
Parameter 3 of 20 (omdb.oracleSid)Please enter the SID for

the OMDB Oracle database instance. [cmdb]:

To accept the default value cmdb for the Oracle SID, press Enter. The following
prompt appears:

Parameter 4 of 20 (omdb.sysPwd)Please enter the password to
use for the OMDB Oracle SYS user.:

Type the password for the Oracle system password, and then press Enter. The
following prompt appears:

Parameter 5 of 20 (omdb.systemPwd)Please enter the password
to use for the OMDB Oracle SYSTEM user.:
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El Type the password for the SYS user for the OMDB Oracle database instance, and
then press Enter. The following prompt appears:
Parameter 6 of 20 (omdb.pgaAggrTarget)Please enter the value
to use for the PGA AGGREGATE TARGET for the OMDB Oracle
instance (in Megabytes). [80]:

KK To accept the default value 80 for the Oracle sizing parameter, press Enter. The
following prompt appears:
Parameter 7 of 20 (omdb.sgaTarget)Please enter the value to
use for the SGA TARGET for the OMDB Oracle instance (in
Megabytes) . [150]:

EEl To accept the default value 150 for the Oracle sizing parameter, press Enter. The
following prompt appears
Parameter 8 of 20 (omcs.occHost)Please enter the hostname or
IP of the server where the SAS OCC service is running.:

EHF Type the fully qualified domain name or IP address of the server that the Opsware
Command Center (OCC) core component is installed, then press Enter. The following
prompt appears:

Parameter 9 of 20 (omcs.twistUser)Please enter the username
of a SAS admininstator for OMDB to use to connect to the
twist. [admin]:

EE To accept the default value admin, press Enter. The following prompt appears:
Parameter 10 of 20 (omcs.twistPwd)Please enter the password
for the SAS admin user for OMDB to use to connect to the
twist.:

K1 Type the password for the admin account on the SAS installation (the
cast.admin_ passwd parameter value), then press Enter. The following prompt
appears:

Parameter 11 of 20 (omcs.host)Please enter the hostname or IP
of the server where the OMDB Core Services will be installed
(not localhost).:

EH Type the fully qualified domain name or IP address of the server that you are
installing OMDB on, then press Enter.

Do not type localhost for this parameter.

The following prompt appears:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.



Chapter 3: Installing OMDB

Parameter 12 of 20 (omcs.port)Please enter the port on which
the OMDB Core Services will run. [8443]:

EI3 To accept the default value 8443, press Enter. The following prompt appears:

Parameter 13 of 20 (omcs.rsyncPort)Please enter the port on
which the rsync service will run. [8873]:

To accept the default value 8873, press Enter. The following prompt appears:

Parameter 14 of 20 (omcs.rmiObjectPort)Please enter the port
on which RMIObject should run. [14445]:

EE] To accept the default value 14445, press Enter. The following prompt appears:

Parameter 15 of 20 (omcs.webServicesPort)Please enter the
port on which WebServices should run. [8083]:

EE] To accept the default value 8083, press Enter. The following prompt appears:

Parameter 16 of 20 (omdb.adminPwd)Please enter the password
to use for the OMDB database administrator.:

H Type the password, and then press Enter. The following prompt appears:

Parameter 17 of 20 (omdb.applPwd)Please enter the password to
use for the OMDB database applications user.:
Consider using a non-default password.

EXl Type the password, and then press Enter. The following prompt appears:

Parameter 18 of 20 (omdb.reporterPwd)Please enter the
password to use for the OMDB database reporter user.:

EH Type the password, and then press Enter. The following prompt appears:

Parameter 19 of 20 (omcs.smtpHost)Please enter the hostname
or IP address of your SMTP mail server. [localhost]:

EE] Perform one of the following two actions:
+ Type the name of the mail server that OMDB should use, then press Enter.
» To accept the default value localhost, press Enter.

The following prompt appears:

Parameter 20 of 20 (omcs.smtpPort)Please enter the port on
which your SMTP mail server is listening. [25]:

EXA To accept the default value 25, press Enter. The following prompt appears

All parameters have values. Do you wish to finish the
interview? (y/n):

To finish the interview, type vy, then press Enter.

To complete the installation, see step 14 on page 38, and then complete steps 14 to 27.
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This chapter discusses the following topics:

Supported Data Sources for OMDB Data Miners
Pre-registering a Data Miner

Installing and Configuring Data Miners for SAS
Installing and Configuring Data Miners for NAS
Installing and Configuring Data Miners for ASAS
Installing and Configuring Data Miners for PAS

Starting the Data Miner

Supported Data Sources for OMDB Data Miners

The following list of data sources are supported for OMDB Data Miners:

SAS 7.0

SAS 6.5.1

NAS 6.1,6.2,6.3, 7.0

» Oracle 9i (9.2.0.7)

» Oracle 10g (10.2.0.2)

« SQL Server 2005

PAS 2.2, 7.0
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If you are installing a Data Miner on NAS 7.0 or PAS (either 2.2 or 7.0), Java J2SE v 1.4.2_
15 JRE must be installed on the system that the OMDB Data Miner is installed on to. To
download this version of Java, go to http://java.sun.com/products/archive/j2se/1.4.2_15/
index.html.

Pre-registering a Data Miner

You will need to pre-register your Data Miner on the OMDB server. This will set up all of
the information needed by a Data Miner to connect to its data source. As part of the
process, you will create a registration token that you will use when configuring the Data
Miner on the SAS and NAS servers.

You can use the command line option to preregister the Data Miner. All values can be
entered on a single command line, and you can skip the entire interactive configuration
that is shown in “Pre-registering a Data Miner Interactively Using dmconfig.sh” on page
50.

For details on the parameters, see “Pre-registering a Data Miner Interactively Using
dmconfig.sh” on page 50, or at a command prompt run the following command:

./dmconfig.sh --help

Pre-registering a Data Miner for SAS and Oracle
To pre-register a Data Miner for SAS and Oracle, perform the following steps:
H < /opt/opsware/omdb/bin

A ./dmconfig.sh --add --name SASserver --desc SAS on SASserver
--type SAS --driver Oracle Driver --properties
database=SASserver.example.com:1521:<SID>,user=<users, passwo

rd=<password>
To avoid including the OMDB Administrator password in every dmconfig.sh command,
you can add password=omdb_admin passwordto the file dmconfig.properties
located in /opt/opsware/omdb/bin. The password is stored in the file in clear text.
Pre-registering a Data Miner for NAS and Oracle

To pre-register a Data Miner for NAS and Oracle, perform the following steps:

H < /opt/opsware/omdb/bin
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A ./dmconfig.sh --add --name NAS --desc NAS on NASserver --type
NAS --driver Oracle Driver --properties
database=NASserver.example.com:1521:<SID>,user=<user>,passwo

rd=<password>

Write down the registration token that appears after you run this command. You will need
to enter it later when configuring the Data Miner on the NAS server. Registration tokens
are uppercase text.

+ The database and user/password information in this example are for the NAS database,
not OMDB.

* When you are prompted for a user name and password, enter cmdb _admin / omdb
admin_password (the password set during the OMDB install for the OMDB
database administrator).

If NAS is not installed with a user name of system, you must set the
Et1TableOwnerOverride value as shown in step 2. Set the value to the name of the
database user who owns the table. For example, if the database user name is dbo, add
the following at the end of the command:

--settings EtlTableOwnerOverride=dbo

The Oracle user OPSW_OMDBXM must have its disk quota setting set to unlimited to auto-
extend the tablespace used for NAS database transaction triggers. If this user’s disk
quota setting is not set as unlimited, NAS users may have problem logging in when
OPSW_OMDBXM hits the quota limit.

Pre-registering a Data Miner for NAS and SQL Server 2005
To pre-register a Data Miner for NAS and SQL Server 2005, perform the following steps:
H ca /opt/opsware/omdb/bin

2] ./dmconfig.sh --add --name sglserver05b --desc NAS on MSSQL
2005--type NAS --driver SQL Server --properties
database=sqglserver05b.example.com:1433/
TrueControl,user=opsware, password=password --settings
Et1lTableOwnerOverride=dbo

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 49



Opsware® OMDB 7.0 Installation Guide

Write down the registration token that appears after you run this command. You will need
to enter it later when configuring the Data Miner on the NAS server. Registration tokens
are uppercase text.

» The database and user/password information in this example are for the NAS database,
not OMDB.

* When you are prompted for a user name and password, enter cmdb_admin / omdb_
admin_password (the password set during the OMDB install for the OMDB
database administrator).

If NAS is not installed with a user name of system, you must set the
Et1lTableOwnerOverride value as shown in step 2. Set the value to the name of the
database user who owns the table. For example, if the database user name is dbo, add
the following at the end of the command:

--settings EtlTableOwnerOverride=dbo

Pre-registering a Data Miner for PAS and Oracle
To pre-register a Data Miner for PAS and Oracle, perform the following steps:
EH cd /opt/opsware/omdb/bin

A ./dmconfig.sh --add --name nc34.pas --desc nc34 Pas Db --type
PAS --driver Oracle Driver --properties
database=pas.nc34.ncdev.opsware.com:1521:XE, user=pas, passwor

d=cmdb_admin

Pre-registering a Data Miner Interactively Using dmconfig.sh

You need to pre-register your Data Miner on the OMDB server. This will set up all of the
information needed by a Data Miner to connect to its data source. As part of the process,
you will create a registration token that you will use when configuring the Data Miner on
the SAS and NAS servers. To pre-register a Data Miner Interactively with dmconfig.sh,
perform the following steps:

H Run the Data Miner configuration tool dmconfig. sh with the following two
commands:
cd /opt/opsware/omdb/bin
./dmconfig.sh

The following prompt should now be displayed:
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[ DMConfigure <]

At the [ DMConfigure <] prompt, the following commands are supported:
« ADD: Displays the prompts that enable you to generate a registration token.

« UPDATE: Displays a list of properties, noting the required properties. Enter
keyvalue pairs until done, and then press Enter to end.

« LIST: Displays current Data Miner configurations.

* QUIT: Exits the prompt.

(Optional) You may be prompted for the database information for the OMDB server.

Unless you made changes during the installation, use the following values. (If not
prompted for some or all of these, it is because the values were found in
dmconfig.properties.)

« Database [host:port:sid]: localhost:1521:cmdb
+ Userid: cmdb_admin

» Password: the password set during the OMDB install for the OMDB database
administrator

Type add and then press Enter.
Follow the prompts to generate a new registration token.

+ Name: Enter a short name for the data source you are planning to mine.

Example: SASserver

» Description: Enter a meaningful name.

Example: SAS on SASserver

+ Connection Template ID: Enter the number listed for Oracle Driver (probably 1).

Pick source ID: Enter 1 for SAS or 2 for NAS.

The following example shows how this step should display:

[ DMConfigure <] add
Name : m500
Description : SAS on SASserver

ID NAME

1 Oracle Driver
Connection template ID : 1

ID NAME
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1 SAS
2 NAS
Source type id : 1

REG TOKEN is WD2K5R

Write down the registration token (in the example, registration token is the string
WD2K5R). You will need to enter it later when configuring the Data Miner on the SAS or
NAS box.

Now that the initial add is complete, you need to update the specific database
configuration for the Data Miner source.

@ Atthe [ DMConfigure # <] prompt type update and then press Enter.

Select the configuration you want to update. Because there is only a single

configuration at this point, select 1. The following prompt appears:

[ DMConfigure # <] update
ID NAME DESCRIPTION TOKEN

1 SASserver SAS on SASserver EM1U6O
ID to update : 1

Set the connection information that the Data Miner (to be installed shortly on the SAS
or NAS server) will use to connect to its local source database (use lowercase). Each
time you enter a value, the current values for the Data Miner source will display.

These values are for the SAS or NAS database, not the OMDB database. Your values
will look similar to the following example:

database=10.124.6.02:1521:truth (Note that database is of
the format host:port:sid)

user=opsware_admin

password=opsware_ admin

El When you are finished, press Enter to exit edit mode and return to the prompt.

KK Type quit, and then press Enter. The OMDB server-side configuration for the Data

Miner is now complete.
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Setting Configuration Options Using dmconfig.sh

The Data Miner periodically connects to OMDB and retrieves miscellaneous configuration
settings. You can set the following values:

Table 4-2: Data Miner Configuration Settings

CollectionInterval

VaultConfigFileDir

InitialCollectionDate

DataFileChunkSize

FileTransferGroupSize

FileTransferlnterval

DataFileUseClearText

(Use for debugging only)

EtITableOwnerOverride

TriggerMineHistoryDays

adjusts the frequency of the
query mine, in milliseconds

specifies the location of the
vault configuration file

the start date and time of a
Data Miner. Set a future
value to delay the start.

the number of transactions
in a Data Miner data file

the number of files per
rsync transfer, per zip

the frequency of file transfer
tasks, in milliseconds

The Data Miner base64
encodes data to support
both UTF8 and embedded
CDATA. Set to true to use
only CDATA.

Note: If true, data xml may

fail to load, and some occur-

rences of UTF8 data may
cause the data file to fail
signature validation.

ETL specified owner

Number of days of Trigger
Mining history to keep

5 minutes (300000)

letc/opt/opsware/vault/

1980-01-01 12.00.00

1500

250

30 seconds (30000)

false

SYSTEM
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These parameters are stored in cmdb_meta.cmdb_parameters where
namespace='cmdb.datasource' and owner_id = source_id.

To set these parameters, at a prompt enter the following command:

./dmconfig.sh --update --name {dm name} --settings

setting=value[, setting=value]

You can also add custom settings which may be used for custom Data Miners.

Listing Data Miners
To list the Data Miners on a Solaris or Linux server, perform the following steps:

H Log in to the server that the Data Miner is running on, and then start a command
prompt.

H Type the following command:
/etc/init.d/opsware-dataminer list
The following is an example of the kind of output from the list option:
The following DataMiners are registered on this machine:
DataMiner #1 token:3M2C2 location /opt/opsware/dataminer
type:SAS
DataMiner #2 token:XXX123 location /opt/opsware/dataminerx

type:Not yet retrieved from OMDB Core

Unregistering a Data Miner

To unregister a Data Miner from the list of Data Miners running on a Solaris or Linux
server, perform the following steps:

E Perform the steps in “Listing Data Miners”.
Note the token value displayed for the Data Miner you want to remove.

H Change directory to the location where the Data Miner is installed. By default, the first
Data Miner installed on a system is installed to /opt/opsware/dataminer.

E Enter the following command:
/.dmsetup.sh --unregister TOKEN
where TOKEN s the token value of the Data Miner you noted in step 1.

Unregistering a Data Miner comments out the entry for that Data Miner in
dataminers.conf. For information on the dataminers. conf file, see “Reading the
dataminers.conf File”.
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Reading the dataminers.conf File

When you run dmsetup. sh, it creates or updates a file /etc/opt/opsware/omdb/
dataminers.conf that includes information on all Data Miners installed on that server.
If the dataminers. conf file exists when you install a new Data Miner, dmsetup . sh
updates the file with the new information, and adds 1 to the ConfiguredDataMiners
value. When uninstalling a Data Miner, dmsetup.sh comments out the specified Data
Miner entry in dataminers. conf, and then decreases the ConfiguredDataMiners
value by 1.

Installing and Configuring Data Miners for SAS

After the Data Miner is configured on the OMDB server, you will copy Data Miner files and
configure them on the data source machine—the actual SAS server.

Installing a Data Miner on a SAS Server
To copy the Data Miner files to the data source servers, perform the following steps:
H Log in to the SAS server.

2] Do a remote copy of dataminer. tar from /opt/opsware/omdb/dist on the
OMDB server to a local directory such as /opt/opsware/dataminer. The
commands used for this step are shown in the following example:
scp youromdbserver:/opt/opsware/omdb/dist/dataminer.tar
/opt/opsware/

B Untar the file:
cd /opt/opsware/
tar -xvf dataminer.tar

Bl Run the dataminer setup using the following command:

./dmsetup.sh

The following prompt appears:
Please enter the registration token provided after this

dataminer was configured on the OMDB server: []

H Enter the token that was generated by registration on the OMDB server. (You were
told to write it down earlier in these instructions. It will be a secure one-use mixture of
about 6 uppercase letters and digits.) The following prompt appears:

Updating token in dataminer.conf
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Would you like to have this dataminer automatically start up
when the system reboots? y/n:

Type v, then press Enter. The following prompt appears:

Dataminer is now configured for startup:

To exit dmsetup. sh, type y, then press Enter.

You can also use command-line parameters with dmsetup.sh to run non-interactively. See
“Running dmsetup.sh Using Command-line Parameters” on page 56.

Enabling Mesh Vault Mining (SAS Only)

To enable mesh vault mining, perform the following steps:

Using the SAS Web Client, log in to a server in the multimaster mesh.

Log in as a user that has the permission Configure Opsware.

[~ o> I o I

In the Navigation Panel, click Administrations » System Configuration »
Facilities, and then click the name of the server that you copied the Data Miner files
to.

Set the cmdbshareddirectory parameter to /var/opt/opsware/vault/

spool.

Set the emdbbufferflushsize parameterto 15360.
Set the emdbbufferflushtimeout parameterto 2000.
Set the cmdbmaxfileage parameterto 3.

Click Save.

Restart the vault daemon on the server that the Data Miner is installed on.

Running dmsetup.sh Using Command-line Parameters

You can use optional parameters when launching dmsetup.sh on a Solaris or Linux

server. For example, entering the command

dmsetup.sh --help
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on any Solaris or Linux server that a Data Miner is installed on displays the available
parameters and the definitions of those parameters. Table 4-3 displays the available

parameters and their definitions.

Table 4-3: dmsetup.sh

--token ABC123

--autostart

--noautostart

--unregister

--register

--help

configure the dataminer to use the token
ABC123

Sets the Data Miner to start at system boot

Sets the Data Miner to not automatically
start at system boot

Removes the specified Data Miner from the
list of Data Miners running on the server

Adds the specified Data Miner to the list of
Data Miners running on the server

Displays the parameters usable with
dmsetup.sh and their definitions

Installing and Configuring Data Miners for NAS

This section describes the following tasks:

Installing and Configuring a Data Miner on a NAS Server on Linux or Solaris

Installing Transaction Mining Triggers for NAS with Oracle on Linux or Solaris

Installing Transaction Mining Triggers for NAS with Oracle on Windows

Installing Transaction Mining Triggers for NAS with SQL Server on Windows

Configuring a Data Miner on a NAS Windows Server

Installing a Data Miner on a NAS Windows Server

Starting a Data Miner on a NAS Windows Server
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Installing and Configuring a Data Miner on a NAS Server on Linux or Solaris

After the Data Miner is configured on the OMDB server, you will copy Data Miner files and
configure them on the data source machine—the actual NAS server.

To copy the Data Miner files to the data source servers, perform the following steps:
H Log in to the NAS server.

H Do a remote copy of dataminer. tar from /opt/opsware/omdb/dist on the
OMDB server to a local directory such as /opt/opsware/dataminer. The
commands used for this step are shown in the following example:
scp youromdbserver:/opt/opsware/omdb/dist/dataminer.tar
/opt/opsware/

E Untar the file:
cd /opt/opsware/
tar -xvf dataminer.tar

Bl Run the dataminer setup using the following command:

./dmsetup.sh

The following prompt appears:
Please enter the registration token provided after this

dataminer was configured on the OMDB server: []

B Enter the token that was generated by registration on the OMDB server. (You were
told to write it down earlier in these instructions. It will be a secure one-use mixture of
about 6 uppercase letters and digits.) The following prompt appears:

Updating token in dataminer.conf

Would you like to have this dataminer automatically start up
when the system reboots? y/n:

@ Type v, then press Enter. The following prompt appears:

Dataminer is now configured for startup:

To exit dmsetup. sh, type y, then press Enter.
Installing Transaction Mining Triggers for NAS with Oracle on Linux or
Solaris

This section describes how to install transaction mining triggers for a NAS installation on a
Linux or Solaris server using Oracle.

You will need the following information before you begin:
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» The Oracle SID of the NAS database instance

+ The Oracle database user owning the NAS table

« An existing tablespace with 100MB available for OMDB transaction data

To prepare for installing transaction mining triggers on a NAS Linux or Solaris server,

perform the following steps:

Stop the OMDB Data Miner if it is running.
Log in to the NAS database server as user oracle.

Confirm the files in the /opt/opsware/dataminer/triggers/oracle on the
OMDB server are accessible by the oracle user on the NAS database server. Set
the file ownership and permissions so that the oracle user can read the files in the

directory, and can execute the deploy nas triggers.sh script.

Type the following commands:
chmod o+x /opt/opsware/dataminer/
chmod o+x /opt/opsware/dataminer/triggers

chmod o+x /opt/opsware/dataminer/triggers/oracle

Type the following command:

chmod o+r /opt/opsware/dataminer/triggers/oraclex*

Type the following command:

chmod o+x /opt/opsware/dataminer/triggers/oracle*.sh

If the Data Miner installation is not installed on the server, copy the /opt/opsware/

dataminer/triggers/oracle directory from a server the NAS Data Miner is installed

on to the NAS database server.

To install transaction mining triggers on a NAS Linux or Solaris server, perform the
following steps:

Open a comand prompt and then log in as the user oracle.

Type the following command:

cd /opt/opsware/dataminer/triggers/oracle

Type the following command:
./deploy nas_ triggers.sh
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Bl Respond to all prompts .

H (Optional) If you stopped the Data Miner in the first step, restart it.

Installing Transaction Mining Triggers for NAS with Oracle on Windows

This section describes how to install transaction mining triggers for a NAS installation on a
Windows server using Oracle.

You will need the following information before you begin:

+ The Oracle SID of the NAS database instance

« The Oracle database user owning the NAS table

+ An existing tablespace with 100MB available for OMDB transaction data

To install transaction mining triggers on a NAS and Oracle Windows server, perform the
following steps:

E (Optional) Stop the OMDB Data Miner if it is running.

H Log in to the NAS database server as a user that is a member of the ORA_DBA
group.

E Confirm the files in the /opt /opsware/dataminer/triggers/oracle on the
OMDB server are accessible by the ORA_DBA group member user on the NAS
database server. If the Data Miner installation is on another server, copy the /opt/
opsware/dataminer/triggers/oracle directory to the NAS database server.
A suggested location is C: \opsware\dataminer\triggers\oracle

Confirm the sglplus.exe application is in the user’s path.

In the C:\opsware\dataminer\triggers\oracle directory, run the following
command:

deploy nas_triggers.cmd

B Respond to all prompts.

(Optional) If you stopped the Data Miner in the first step, restart it.

Installing Transaction Mining Triggers for NAS with SQL Server on Windows

This section describes how to install transaction mining triggers for a NAS installation on a
Windows server using SQL Server.

You will need the following information before you begin:
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+ The name of the NAS application schema

+ The name of the user account created during the NAS installation

To find these names, perform the following steps:

Start NAS.

Select System Status in the Admin menu.

Select DatabaseMonitor.

In the Actions field, select View Details. The Monitor Details page displays.

Find and write down the values for

» Database catalog

» Database user name

To install transaction mining triggers on a NAS and SQL Server Windows server, perform

the following steps:

(Optional) Stop the OMDB Data Miner if it is running.

Inthe C:\opsware\dataminer\triggers\sglserver directory, run the
following command:

deploy nas_triggers.cmd

The following prompt appears:

Deployment will remove existing OMDB transaction data from

previous deployments. Continue? [Y]

Type y, and then press Enter. The following prompt appears:

Which SQL Server instance contains the NAS database?
[default]

To accept the default value of SQL Server, press Enter.

Or

Type the name of the SQL Server instance. For example, type SQLExpress to
select SQL Server Express.

The following prompt appears:
Which SQL Server database contains the NAS application

schema? [default]:

Type the value of the NAS ‘Database catalog’ you wrote down in step 5 on page 61,
and then press Enter. The following prompt appears:
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Which database user does the NAS application use to connect
to the database? [nas]:

Type the value of the NAS ‘Database user name’ you wrote down in step 5 on page
61, and then press Enter. The following prompt appears:

Which database schema contains the NAS application tables?
[dbo] :

To accept the default value dbo, press Enter.

EIJ (Optional) If you stopped the Data Miner in the first step, restart it.

Configuring a Data Miner on a NAS Windows Server

After the Data Miner is configured on the OMDB server, you will copy Data Miner files and
configure them on the data source machine—the actual NAS server. To configure a Data
Miner on a NAS Windows server, perform the following steps:

On the Windows NAS server, create a directory, such as C:\dataminer.

Copy the dataminer. zip and dmboot .pem file from /opt/opsware/omdb/
dist on the OMDB server to a local directory, such as C:\dataminer.

Unzip the dataminer. zip file. Keep the directory structure intact.

Edit the file jvm.properties. Update the JVM-Path value to the correct location of
JVM.DLL for the Java Runtime Environment 1.4.2.

Edit the dataminer.conf file using the following example:

#0OpswareGateway=host:port
CMDBLocation=10.10.10.10:8443
RestartableCopylLocation=10.10.10.10:8873
RegistrationToken=ToKeN

LogLevel=INFO

Leave OpswareGateway as a comment (preceded by #)
Set CMDBLocation to the OMDB Server <host>:8443

Set the port number of CMDBLocation to the value set for the ocms.rsyncPort when

you installed OMDB. The default port value is 8443.

Set the port number of RestartableCopyLocation to the value set for the

ocms.rmiObjectPort when you installed OMDB. The default port value is 8873.
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+ Set RegistrationToken to the token generated at registration on the OMDB Server

+ RestartableCopyLocation should be set to the same IP address as
CMDBLocation:8873

Installing a Data Miner on a NAS Windows Server

To install a Data Miner on a NAS Windows server, perform the following steps:

EH Open a Windows command prompt.

H Change directory to C: \dataminer.

E To install the service, run the following command:

DataMinerService -install

Starting a Data Miner on a NAS Windows Server

To start a Data Miner on a NAS Windows server, perform the following steps:
EH Open a Windows command prompt.

H Change directory to C: \dataminer.

E To start the service, run the following command:

DataMinerService -start

Installing and Configuring Data Miners for ASAS

Data Miners for ASAS work differently than Data Miners for either SAS or NAS. The ASAS
Data Miner process first mines from the ASAS source server to a staging database in the
OMDB database instance, and then transfers data from the OMDB staging database to
the OMDB main database instance. To mine data from an ASAS system, you must:

« Install and configure a SAS Data Miner for the SAS server that ASAS is installed on.

» Register the ASAS Data Miner on OMDB to create a database link and set up a
scheduled ASAS-specific mining job. This scheduled job moves data from the ASAS
source server to the OMDB staging database.

+ Install the standard OMDB Data Miner and configure it to communicate with the staging
database on OMDB. When the scheduled ASAS-specific mining job completes, it
triggers the OMDB data miner to then mine data from the OMDB staging database to
the OMDB main database instance.

This section describes the following tasks:

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 63



Opsware® OMDB 7.0 Installation Guide

» Configuring the OMDB Database for the ASAS Data Miner

+ Pre-registering a Data Miner for ASAS and Oracle

.

Installing and Configuring a Data Miner for an ASAS Server

Mining ASAS Data

Configuring the OMDB Database for the ASAS Data Miner

To configure the OMDB database instance for an ASAS Data Miner, perform the following
steps:

El Ensure that the desired ASAS source system is properly installed and operational.

B Install and configure a SAS Data Miner for the SAS server that ASAS is installed on.

EF Log in to the OMDB database server.

Bl Atacommand prompt,in /u01/app/oracle/product/10.2.0/db 1/
network/admin, create a tnsnames . ora entry for the ASAS source database.
asasl =

(DESCRIPTION =
(ADDRESS LIST = (ADDRESS = (PROTOCOL = TCP) (HOST =
asashost.opsware.com) (PORT = 1521))

)

(CONNECT DATA
(SERVICE_NAME = truth)
)

)

On the OMDB database server, start SQL*Plus or other database tool.
@ Asthe user ASAS RPT USER, run the following command:

etlinterface.registerPlaformDatabase
to register the source system.

For each additional ASAS source server, repeat the above steps.

Examples of the etlinterface.registerPlaformDatabase parameter
declarations are shown below.

declare
-- Service name defined in the OMDB tnsnames.ora file

DbNetServiceName varchar2(30) := 'asasl';
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-- The user name for connection to the ASAS source database

DbUserName varchar2(30) := 'opsware_admin';

-- The password for connection to the ASAS source database

DbPassword varchar2(30) := 'opsware_admin';
-- A description of this registered ASAS source

DbDescription varchar2(100) := 'ASAS Source 1';

-- The unique Oracle link name. This name (with current

database domain appended)

-- must match the source database's global name OR the local

global names database
-- parameter must be 'false'

DbLinkName varchar2(30) := 'asasl dblink';

-- The hostname of the ASAS source database server.

should match the hostname
-- in the tnsnames.ora entry.
DbHost varchar2(100) := 'asashost.opsware.com';

begin

This

etlinterface.registerPlatformDatabase ( DbNetServiceName,

DbUserName, DbPassword, DbDescription, DbLinkName, DbHost

end;

/

Pre-registering a Data Miner for ASAS and Oracle

To pre-register a Data Miner for ASAS and Oracle, perform the following steps:

H Log in to the OMDB database server.

H <3 /opt/opsware/omdb/bin

3] ./dmconfig.sh --add --name ASAS --desc Local ASAS data

type ASAS --driver Oracle --properties
database=localhost:1521:cmdb,user=asas_rpt__

user,password=cmdb_admin

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.

65



Opsware® OMDB 7.0 Installation Guide

Write down the registration token that appears after you run this command. Registration

AN
tokens are uppercase text.

The ASAS example uses localhost because the ASAS Data Miner is installed on the
OMDB Core server. You can specify the host name of the OMDB Core server.

Installing and Configuring a Data Miner for an ASAS Server

After the Data Miner is configured on the OMDB server, you will copy Data Miner files and
configure them on the data source machine—the OMDB Core server.

Log in to the OMDB Core server.

Do a remote copy of dataminer. tar from /opt/opsware/omdb/dist on the
OMDB server to a local directory such as /opt/opsware/dataminer. The
commands used for this step are shown in the following example:

scp youromdbserver:/opt/opsware/omdb/dist/dataminer.tar
/opt/opsware/

Untar the file:

cd /opt/opsware/

tar -xvf dataminer.tar

Run the dataminer setup using the following command:

./dmsetup.sh

The following prompt appears:

Please enter the registration token provided after this
dataminer was configured on the OMDB server: []

Enter the token that was generated by registration on the OMDB server. (You were
told to write it down earlier in these instructions. It will be a secure one-use mixture of
about 6 uppercase letters and digits.) The following prompt appears:

Updating token in dataminer.conf

Would you like to have this dataminer automatically start up
when the system reboots? y/n:

Type v, then press Enter. The following prompt appears:

Dataminer is now configured for startup:

To exit dmsetup. sh, type vy, then press Enter.
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Mining ASAS Data

ETL procedures on the ASAS server mine ASAS data from the ASAS server into a staging
schema in the OMDB database instance. A scheduled Oracle job runs this ETL procedure
against all registered ASAS servers daily at midnight UTC.

You can run this process at other times, such as immediately after registering the ASAS
server. To run the ETL procedure, perform the following steps:

EH Onthe OMDB database server, start SQL*Plus or other database tool.

H Run the following command:
begin
dbms_scheduler.run_job(
job name=>'asas rpt user.asas_Run _etl',
use current session=>false
)i

end;

Installing and Configuring Data Miners for PAS

This section describes the following tasks:

+ Installing and Configuring a Data Miner on a Linux or Solaris PAS Server

« Configuring a Data Miner on a PAS Windows Server

+ Installing a Data Miner on a PAS Windows Server

« Starting a Data Miner on a PAS Windows Server

+ Installing Transaction Mining Triggers for PAS with Oracle on Linux or Solaris

+ Installing Transaction Mining Triggers for PAS with SQL Server on Windows
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Installing and Configuring a Data Miner on a Linux or Solaris PAS Server

After the Data Miner is configured on the OMDB server, you will copy Data Miner files and
configure them on the data source machine—the actual PAS server. To copy the Data
Miner files to the source servers, perform the following steps:

Log in to the PAS server.

Do a remote copy of dataminer. tar from /opt/opsware/omdb/dist on the
OMDB server to a local directory such as /opt/opsware. The commands used for
this step are shown in the following example:

scp youromdbserver:/opt/opsware/omdb/dist/dataminer.tar
/opt/opsware/

Unzip the file:

cd /opt/opsware/

tar -xvf dataminer.tar

Run the dataminer setup using the following command:

./dmsetup.sh

The following prompt appears:
Please enter the registration token provided after this

dataminer was configured on the OMDB server: []

Enter the token that was generated by registration on the OMDB server. (You were
told to write it down earlier in these instructions. It will be a secure one-use mixture of
about 6 uppercase letters and digits.) The following prompt appears:

Updating token in dataminer.conf
Would you like to have this dataminer automatically start up
when the system reboots? y/n:

Type vy, then press Enter. The following prompt appears:

Dataminer is now configured for startup:

To exit dmsetup. sh, type vy, then press Enter.

Configuring a Data Miner on a PAS Windows Server

To configure a Data Miner on a PAS Windows server, perform the following steps:

On the Windows PAS server, create a directory, such as C:\dataminer.

Copy the dataminer. zip and dmboot .pem file from /opt/opsware/omdb/
dist on the OMDB server to a local directory, such as C:\dataminer.
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Unzip the dataminer. zip file. Keep the directory structure intact.

Edit the file jvm.properties. Update the JVM-Path value to the correct location of
JVM.DLL for the Java Runtime Environment 1.4.2.

B Edit the dataminer.conf file using the following example:

#0OpswareGateway=host:port
CMDBLocation=10.10.10.10:8443
RestartableCopylLocation=10.10.10.10:8873
RegistrationToken=ToKeN

LogLevel=INFO

+ Leave OpswareGateway as a comment (preceded by #)
+ Set CMDBLocation to the OMDB Server <host>:8443

+ Set the port number of CMDBLocation to the value set for the ocms.rsyncPort when
you installed OMDB. The default port value is 8443.

+ Set the port number of RestartableCopyLocation to the value set for the
ocms.rmiObjectPort when you installed OMDB. The default port value is 8873.

+ SetRegistrationToken to the token generated at registration on the OMDB Server

+ RestartableCopyLocation should be set to the same IP address as
CMDBLocation:8873

Installing a Data Miner on a PAS Windows Server

To install a Data Miner on a PAS Windows server, perform the following steps:

EH Open a Windows command prompt.

H Change directory to ¢: \dataminer.

HE To install the service, run the following command:
DataMinerService -install

Starting a Data Miner on a PAS Windows Server
To start a Data Miner on a PAS Windows server, perform the following steps:
EH Open a Windows command prompt.

H Change directory to C: \dataminer.
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E To start the service, run the following command:

DataMinerService -start
Installing Transaction Mining Triggers for PAS with Oracle on Linux or
Solaris

This section describes how to install transaction mining triggers for a PAS installation on a
Linux or Solaris server using Oracle.

You will need the following information before you begin:

+ The Oracle SID of the PAS database instance

» The Oracle database user owning the PAS table

» An existing tablespace with 100MB available for OMDB transaction data

To prepare for installing transaction mining triggers on a PAS Linux or Solaris server,
perform the following steps:

E Stop the OMDB Data Miner if it is running.
H Log in to the PAS database server as the user that installed the Data Miner.

E Confirm the files in the /opt /opsware/dataminer/triggers/oracle on the
OMDB server are accessible by the oracle user on the PAS database server. Set the
file ownership and permissions so that the oracle user can read the files in the
directory, and can execute the deploy pas triggers.sh script.

B Type the following commands:
chmod o+x /opt/opsware/dataminer/
chmod o+x /opt/opsware/dataminer/triggers

chmod o+x /opt/opsware/dataminer/triggers/oracle

B Type the following command:

chmod o+r /opt/opsware/dataminer/triggers/oraclex*

@ Type the following command:

chmod o+x /opt/opsware/dataminer/triggers/oracle*.sh

If the Data Miner installation is not installed on the server, copy the /opt/opsware/
dataminer/triggers/oracle directory from a server the PAS Data Miner is installed
on to the PAS database server.
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To install transaction mining triggers on a PAS Linux or Solaris server, perform the
following steps:

Open a comand prompt and then log in as the user oracle.
Type the following command:
cd /opt/opsware/dataminer/triggers/oracle

Type the following command:
./deploy pas_triggers.sh

Respond to all prompts.

(Optional) If you stopped the Data Miner in the first step, restart it.

Installing Transaction Mining Triggers for PAS with SQL Server on Windows

This section describes how to install transaction mining triggers for a PAS installation on a
Windows server using SQL Server.

You will need the following information before you begin:

+ The name of the PAS application schema

» The name of the user account created during the PAS installation

To install transaction mining triggers on a PAS and SQL Server Windows server, perform
the following steps:

(Optional) Stop the OMDB Data Miner if it is running.

In the C:\opsware\dataminer\triggers\sqglserver directory, run the
following command:

deploy pas_triggers.cmd

The following prompt appears:

Deployment will remove existing OMDB transaction data from

previous deployments. Continue? [Y]
Type y, and then press Enter. The following prompt appears:

Which SQL Server instance contains the PAS database?
[default]

To accept the default value of SQL Server, press Enter.

Or

Type the name of the SQL Server instance. For example, type SQLExpress to
select SQL Server Express.
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The following prompt appears:
Which SQL Server database contains the PAS application

schema? [default]:

Type the value of the PAS ‘Database catalog’, and then press Enter. The following
prompt appears:

Which database user does the PAS application use to connect
to the database? [pas]:

Type the value of the PAS ‘Database user name’, and then press Enter. The following
prompt appears:

Which database schema contains the PAS application tables?
[dbo] :

To accept the default value dbo, press Enter.

K (Optional) If you stopped the Data Miner in the first step, restart it.

Starting the Data Miner

To start the Data Miner, perform the following steps:

At a prompt, change to the directory you installed the Data Miner to.

Type the following command:

/ .dataminer.sh start
Tail the dataminer.log to observe progress.
tail -f /opt/opsware/dataminer/dataminer.log

You should see the tail of the Data Miner log display content similar to the following
example:

INFO - - - - - "Configuration Path = /opt/opsware/dataminer"
INFO - - - - - "Using configuration file /opt/opsware/
dataminer/dataminer.conf"

INFO - - - - - "Initializing..."

INFO - - - - - "Running on Linux"

INFO - - - - - "Cached Configuration file has been updated,
reloading"

INFO - - - - - "Boot certificate not found Attempt to import"
INFO - - - - - "Boot certificate successfully imported"

INFO - - - - - "DataMiner successfully registered"

When you are satisfied that the Data Miner is correctly configured and collecting
data, you can stop the tail command.
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This chapter discusses the following topics:
« Starting and Stopping OMDB
+ Creating and Assigning Security Boundaries
+ PAS Administrative Tasks
+ OMDB Filesystem Layout
+ Files Modified By the OMDB Installer at Installation

+ OMDB Architecture and Components

Starting and Stopping OMDB

This section describes the opsware-omdb script used to start OMDB. After installation,
the script is located in the /etc/init.d/ directory:

/etc/init.d/opsware-omdb

The opsware-omdb script has the following options:
® start
e stop
® startsync
e restart
e list
e status
e versgion

For more information on these options, see the Opsware® SAS Administration Guide.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved. 73



Opsware® OMDB 7.0 Installation Guide

Creating and Assigning Security Boundaries

The Security Boundaries feature allows you to choose custom search parameters that you
can then save and assign to a user or a group of users in OMDB. You can define a
Security Boundary as one or more attributes of one or more configuration items. You
create a security boundary in the OMDB Client. You assign security boundaries in the SAS
Web Client.

If you select the Security Boundary option, click Select to display the Select Security
Boundaries window.

Creating Security Boundaries

To create a security boundary, perform the following steps:

HF Launch the SAS Client. The SAS Client appears.

H From the Tools menu, select Opsware OMDB Client. The Opsware OMDB Client
window appears.

E From the View menu, select Opsware Administration » Security Boundaries.

Select a Configuration Iltem from the drop-down list.

In the drop-down list for (the Asset Tag, Hostname, and so on), select Contains,
Equals, or the appropriate association.

In the text field, type the appropriate value.

(Optional) Click + and then repeat the preceding three steps to define a second
criteria.

B Click Preview Security Boundary to view the current items defined within the
security boundary.

El Click Save to save the security boundary.

Assigning Security Boundaries
To assign a security boundary to a group, perform the following steps:

H Log into the SAS Web Client as an administrator. The SAS Web Client Home Page
appears.

B In the Navigation Panel, click Administration » Users & Groups. The View Users
pane is displayed.

HE Click the Groups tab. The Groups tab is displayed.
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Bl Select the group you want to set a security boundary for. The group is displayed in
the View Groups pane.

Click the OMDB Features tab. The OMDB Features tab is displayed.

Clear All Data Access Permissions.

For the CI Type you want the group to use a security boundary for access to that
data, select the Security Boundary option.

B Click Select. The Select Security Boundaries window is displayed.

El Click a security boundary in the Unassigned Boundaries list, and then click -=> to
move the selected security boundary to the Assigned Boundaries list.

Kl Click Save. The Select Security Boundaries window closes.
EEl In the OMDB Features of the View Groups pane, click Save.

You can select multiple security boundaries in the Select Security Boundaries window to
control data access for a single Cl Type. Users that are members of groups with different
security boundaries for data access have access to all the data viewable by the individual
groups. For example, suppose a user is a member of two groups:

« SAS Users - Security boundary defined for all SAS data
+ NAS Users - Security boundary defined for all NAS data

The user can see all the Cl Types for both SAS data and NAS data.

PAS Administrative Tasks

To enable PAS actions on objects for OMDB users, the OMDB Administrator must perform
two tasks:

» Define PAS Actions
+ Setting PAS Options

Defining PAS Actions
To define the PAS actions, perform the following steps:

EH On the OMDB server, open a terminal window.
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Using a text editor, open the following file:
/opt/opsware/omdb/deploy/birt.war/pas_actions.xml

The pas_actions.xml file is an example file that provides example Configuration
ltem types and PAS workflows.

Edit the pas_actions.xml file, and then save the file.

Setting PAS Options

To set parameters for PAS workflows, perform the following steps:

Launch the OMDB Client as an OMDB administrator. The OMDB Client appears.
From the View menu, select Opsware Administration » PAS Options.

In the PAS Hostname field, type the PAS server hostname. The field does not allow
spaces. You can enter any DNS-resolvable hostname format, including localhost,
127.0.0.1, pas.server.example.com, or pas_server.

(Optional) In the Port [8443] field, type the port number. The default value is 8443 if
you do not type a different port number.

In the Username and Password fields, type the username and password for the
account on the PAS server the workflow should run as.

Click Save Values.

OMDB Filesystem Layout

This section describes the filesystem layout of the Opsware OMDB Database and the
Opsware OMDB Core Services. The default OMDB database filesystem layout is
presented in Table 5-1.

Table 5-1: OMDB Database Filesystem Layout

/u0l/ Location of Oracle application, instance

admin files, and a control file

/u0l/app/oracle/product/ config for OMDB instance
10.2.0/db_1/network/admin/

tnsnames.ora
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/u0l/app/oracle/product/
10.2.0/db_1/network/admin/

omdb.listener.ora

/u0l/app/oracle/product/
10.2.0/db_1/dbs/orapwcmdb

/u0l/app/oracle/product/
10.2.0/db_1/dbs/spfilecmdb.ora

/u0l/app/oracle/admin/cmdb/
bdump, cdump, pfile, udump

/u0l/app/oracle/admin/cmdb/

create/

/u0l/app/oracle/admin/cmdb/

create/metaschema

/u0l/app/oracle/admin/cmdb/

dataschema
/u0l/oradata/cmdb/
/u02/
/u02/oradata/cmdb/

/u03/oradata/cmdb/

/u04/

/u04/oradata/cmdb/

/etc/oratab
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config for OMDB instance

OMDB password file

OMDB config file

Oracle OMDB instance log and support
files

Scripts to create database

Schema creation scripts

Data creation scripts

OMDB control file #1
Location of data files
OMDB data files

CMDB control file #2, and redo logs group
#1

Location of second member of redo log
groups, and a control file

CMDB control file #1, and redo logs group
#2

Entry for OMDB instance
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The default OMDB Core Services filesystem layout is presented in Table 5-2.

Table 5-2: OMDB Core Services Filesystem Layout

/opt/opsware/omdb
/opt/opsware/omdb/bin
/var/opt/opsware/crypto/omdb/

/opt/opsware/omdb/dist

/opt/opsware/omdb/conf

/opt/opsware/omdb/deploy

/opt/opsware/omdb/deploy/

birt.war/
/opt/opsware/omdb/omdb/

/opt/opsware/omdb/omdb/deploy/

/opt/opsware/omdb/omdb/deploy/

jbossweb-tomcat55.sar/
/opt/opsware/omdb/reports/
/var/opt/opsware/omdb/collect/
/etc/opt/opsware/omdb/
/etc/inet.d/opsware-omdb

/var/log/opsware/omdb/

Root of the primary install location
Location of OMCS binary executables
cryptographic certificates for omdb, twist

Location where the Dataminer installer and
cert are deployed

JBoss configuration directory

OMDB JBoss deploy files that are not in
OCC, such as loadersar, cooper.jar, and so
on

BIRT Engine

Hierarchy is the same as the SAS OCC

JBoss deployment, hierarchy the same as
SAS OCC

Apache webserver deployment directory

OMDB report definitions

Location of OMCS Loader Collect directory
Location of OMCS configuration files
OMCS daemon launch script

Log files for OMDB

Files Modified By the OMDB Installer at Installation
Table 5-3 presents the files modified when installing OMDB.
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Table 5-3: Files Modified By the OMDB Installer at Installation

OMDB properties /etc/opt/opsware/omdb/

omdb . properties - twist security and
scheduled reports settings

Core Services, default port 8443 + /opt/opsware/omdb/omdb/conf/

http-invoker.sar/jboss-
service.xml

Two changes for InvokerURLSuffix

. /opt/opsware/omdb/omdb/
deploy/http-invoker.sar/META-
INF/jboss-service.xml
Two changes for InvokerURLSuffix

. /opt/opsware/omdb/omdb/
deploy/jboss-ws4ee.sar/META-
INF/jboss-service.xml
One change for WebServicesSecurePort

. /opt/opsware/omdb/omdb/
deploy/jbossweb-tomcat55.sar/
server.xml
redirectPort
connector port
keystore password and file (keystoreFile,
keystorePass)

RMIObjectPort, default 14445 /opt/opsware/omdb/omdb/conf/

OMDB rsync

jboss-service.xml

/etc/opt/opsware/omdb/
rsyncd.conf
Change "port" value
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Table 5-3: Files Modified By the OMDB Installer at Installation

OMDB Twist password

SAS Twist

Application Data Source configurations

Cryptographic files (generated at install,
including querying twist for the SAS public

certificate)

Keystore password

/var/opt/opsware/crypto/omdb/
twistpwd

An obfuscated version of the twist pass-
word, created the same way as in SAS. Upu
can change the password by recreating the
file using plaintext. Upon OMDB restart, the
password will be automatically obfuscated.

/opt/opsware/omdb/bin/enable

omdb client.sh
« omdb host
« omdb port

SAS twist.conf changes must be changed
manually or by running this script.

+ /opt/opsware/omdb/deploy/
cmdb-ds . xml

+ /opt/opsware/omdb/deploy/
reporter-ds.xml
Change the connection-url value
for oracle sid, host, port changes.
Change password for Oracle cmdb
appl user password change.

+ /var/opt/opsware/crypto/omdb/

server.keystore

+ /opt/opsware/omdb/dist/
dmboot .pem
Data Miner secure communication.

/opt/opsware/omdb/omdb/deploy/
security-service.xml
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Table 5-3: Files Modified By the OMDB Installer at Installation

Dataminer properties

Dataminer files

Dataminer parameters

/opt/opsware/omdb/bin/

dmconfig.properties
+ oracle host

* port

+ oracle omdbsid

+ omdb admin userid (cmdb_admin), but
is usually not changed

The cmdb_admin password can be
included here as password=xxx but is
not included automatically by the OMDB
Installer. Including the cmdb_admin pass-
word will prevent prompting for the cmdb
admin password when running
dmconfig. sh to install a Data Miner.
/opt/opsware/omdb/dist/
dataminer.tar

This file includes dataminer.conf and
dmboot . pem.

/opt/opsware/omdb/dist/
dataminer.conf

* rsync port

« server (listed as
RestartableCopyLocation)

OMDB Architecture and Components

Opsware OMDB operates with Opsware SAS to provide analysis and data warehousing
capabilities targeted to the operational needs of IT organizations. There are three major
collections of functionality: the OMDB Server, the OMDB Client, and Data Miners.

« The OMDB Server hosts the underlying physical database, core services, and the

loader interface.
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.

The OMDB Client provides a user interface.

Data Miners collect information from source systems and forward the collected
information to the OMDB Server to build the data warehouse.

These components leverage core services provided by a hosting Opsware SAS
installation.

OMDB Server Components

.

AAA Login Module: The AAA Login Module redirects login credentials through the twist
client to the supporting Opsware AAA instance that is shared with the hosting SAS
core.

BIRT: Business Intelligence Reporting Toolkit (BIRT) is the reporting engine which
generates formatted report output. BIRT is an open source component derived from the
Eclipse Project.

Catalog: The Catalog application manages the metadata-based data model. The
catalog is the source of definitions for items, attributes, and relationships. Extensions to
the OMDB data model are managed by the Catalog.

Conveyor: The Conveyor application provides configuration information to a Data Miner
present on a remote data source. The Data Miner receives updates to the ETL
definitions from the Conveyor. These ETL definitions control what information is
collected from each source and how that information is mapped to items, attributes and
relationships in the OMDB database.

Cooper: Cooper is the core web services interface to the OMDB. All OMDB Client data
interaction is controlled by Cooper.

JAAS Security: The Java Authentication and Authorization Service (JAAS) Security
module marshals authentication, functionality authorization, and security filtering of
query information.

Loader: The Loader inserts data records created by Data Miners into the data
warehouse. Because the order of delivery of data from the Data Miners is not
guaranteed, the Loader is responsible for reconstructing the sequence of events as the
records are inserted. The Loader also verifies the incoming data records to confirm the
data is not corrupted.

OMDB JDBC Driver: The OMDB JDBC Driver implements security filtering by refactoring
database queries to limit access to information according to a user’s security rights. The

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2008 Opsware Inc. All Rights Reserved.



Chapter 5: Administration

OMDB JDBC driver acts in conjunction with a standard JDBC Driver to access the
underlying physical representation through the database.

+ OMDB rsync Server: The OMDB Data Miner delivers data records to the Loader using
the rsync protocol. The rsync Server listens for these connections from the Dataminer
and deposits data records for the Loader to process.

» Oracle Database Instance: The OMDB data warehouse uses an Oracle database to
store information.

« Scheduler: The Scheduler component maintains the queue of scheduled reports and
executes those scheduled reports according to their specified schedule.

+ Twist Client: The Twist Client dispatches Opsware Universal APl (UAPI) calls to the Twist
application service of the Opsware SAS Mesh.

OMDB Client

The OMDB Client is the user interface to the Opsware OMDB. The OMDB Client provides
specific capabilities for report presentation, search, ad-hoc searching and report building,
and administrative capabilities.

OMDB Data Miner

OMDB Data Miners collect information for all data sources using the rules specified by the
ETL definitions. This source data is formatted into an XML format along with checksum
and signature information.

SAS Common Services

« Opsware AAA: The Opsware Authentication, Authorization, and Auditing component
provides core AAA services to Opsware SAS and OMDB, including user and group
accounts, authorization for specific OMDB features, and representation of OMDB data
access boundaries.

« Twist: The Opsware Web Service Data Access Engine (Twist) provides programmatic
access to Opsware services. OMDB uses the Twist API to access the Opsware AAA
component.
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